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1.Introduction

This User’s Guide describes how to install, use, and troubleshoot the FireWire

-Ultra SCSI Converter FR1SX(called FR1SX in this User’s Guide).

The information in the README file on the CD-ROM may include the latest

information. Be sure to read the file as well.

1-1.Package Confirmation

     •FR1SX FireWire-Ultra SCSI Converter

     •FR1SX CD-ROM

     •1394 6pin- 6pin cable

     •User’s Guide

     •Software Lisence Agreement

Check Package Contents:

If any of these items are missing from the FR1SX retail package,

 contact your supplier immediately.

NOTE
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1-2.System Requirements and Restrictions

    OS

           •Mac OS X-10.1.x or above/Mac OS 9.1 or above

           •Windows XP/2000/Me/98SE

     SCSI device

           •High-Density 50 pin female SCSI-2 connector on a SCSI device

          •Term-Power output capability

           (Caution)As FR1SX gets electric power from Term-Power on

                           SCSI bus, this output capability is required. If Term

                           -Power output is not available at your SCSI device such

                           as iomega zip drive, you must use an OPTIONAL AC

                           Adapter(sold separately). Refer to Chapter 5-4 and 7.

           •Single-End interface

           •Terminator

     Mac, PC

           •1394 port

           •You can’t daisy-chain SCSI devices.You can connect only one SCSI

             device to the FR1SX.

            If you want to daisy-chain SCSI devices, you have to connect those

             devices via 1394 interface.
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           •The original SCSI based drivers or application software for your

              SCSI devices may not work with the SCSI device through the FR1SX.

           •FR1SX doesn’t support the following function:

                  -Multiple LUN(Logical Unit Number)

           •Some scanners may not work with the FR1SX. For more information,

             refer to our web site(www.ratocsytems.com/english).

           •You can’t boot up system from SCSI devices.

             (For Windows Users Only)

           •If you have a FireWire Embedded PowerMac or PowerBook, you

             can boot up from the SCSI device(HDD or Removable) through

             the FR1SX. Sometimes the Firmware update of PowerMac/

             PowerBook may be required. If it doesn’t work properly, please ask

             to www.apple.com.(For Mac Users Only)

     ���  (NOTE) Apple Firmware doesn’t support boot up from

                           external CD-ROM through FireWire.
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1-3.Front/Back Side Function

6 pin FireWire

(IEEE1394) port

AC Adapter jack

Power LED (Green)

Fig. 1 shows the front side layout of the FR1SX. Power LED light-on

state indicates the FR1SX is powered and ready to work. If this LED doesn’t

come on, refer to Chapter 5-4 and 7.

High-Density 50 pin

SCSI connector

          Push Button

Fig. 2 shows the back side layout of the FR1SX. You can connect a

High-Density 50 pin SCSI device, using the Push Button. If you have a SCSI

device with a Low-Density Centronics 50 pin or DB25 connector, you can

order an OPTIONAL Adapter. In such a case , refer to Chapter 5-6 and 7.

Fig. 1 Front Side

Fig. 2 Back Side
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2.Installation

Follow the steps through to connect your SCSI device to the FR1SX, and

connect it to a PC/Mac:

2-1.Connecting the FR1SX to a SCSI device

�1)Make sure the SCSI device is in Power-OFF state.

       Connect the FR1SX to a SCSI device, as Fig.3 shows. If you have a SCSI

       device with a Low-Density Centronics 50 pin or DB25 connector, you

        can order an OPTINAL Adapter. In such a case , refer to Chapter 5-6 and 7.

Terminator

Fig. 3
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2)Make sure that the SCSI device has a SCSI ID except 7. You can usually

    change a SCSI ID with a switch on the back of the SCSI device. For more

    information, refer to the SCSI device manual.

3)Attach an external active terminator to the SCSI device, as Fig.3 shows.

    If the SCSI device has an internal terminator and the switch, set it on

    state instead of attaching the external active terminator. Refer to the SCSI

    device manual if you are not sure how to terminate the SCSI device.

4)Make sure the SCSI device has Term-Power output capability.

   If the SCSI device doesn’t have this capability, you must use an

    OPTIONAL AC Adapter(sold separately). Refer to Chapter 5-4 and 7.

    Next, you must connect the FR1SX to a PC or Mac.

    If you use a PC, proceed to Chapter 2-2.

    If you use a Mac, proceed to Chapter 2-3.
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2-2.Connecting the FR1SX to a PC

You can now hot plug in the FR1SX to a PC’s available 1394 port.

Follow the steps through:

1)If your PC is powered down, start it now.

2)Connect the FR1SX to the 1394 port via the 1394 cable, as Fig.4 shows.

   1394 port

        1394 cable

Fig. 4
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3)Power up your SCSI device. Make sure the FR1SX’s Power LED comes on.

   If the LED doesn’t come on, refer to Chapter 5-4.

4)If a new drive is assigned at My Computer, as shown below, you have

   successfully installed the FR1SX.

   When you want to remove it from the PC, you must click the hardware

   removable icon at the TaskBar as shown below and select [Stop xxx-

   Disk(X:)]. You will see the message box saying “you can safely remove the

   device”. Click [OK]. You can now remove it.

 NOTE

 If a new drive letter isn’t present, refer to Chapter 5-3.

   If you use a Windows 98 SE, proceed to next page to install the update

   program. If you don’t install it, the hardware removable icon don’t appear at

   the TaskBar.
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5)Windows 98 Second Edition Storage Supplement Update

   If you use Windows 98 SE, you need to install Storage Supplement

   Update available through Microsoft web site. This component improves

   1394 storage performance and also installs a Safe Removal Utility.

   Follow the steps through to install it:

�a)Click Start menu on the TaskBar.

�b)Select Windows Update.

       (http://v4.windowsupdate.microsoft.com/en/default.asp)

�c)The following screen will appear. Click Scan for updates.
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�d)The following screen will appear. Click Windows 98 and Windows 98

       Second Edition. Find Storage Supplement Update and click Add

       button. And then, click Review and install updates.

�e)The following screen will appear. Make sure Storage Supplement

       Update is shown. If you don’t want to install any updates other than

       Storage Supplement Update, click Remove button.

        To install the Storage Supplement Update, click Install Now and

        follow the on-screen instructions.
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2-3.Connecting the FR1SX to a Mac

You can now hot plug in the FR1SX to a Mac’s available FireWire port.

Follow the steps through:

1)If Mac is powered down, start it now.

2)Connect the FR1SX to the FireWire port via the FireWire cable, as Fig.5

    shows.

3)Power up your SCSI device. Make sure the FR1SX’s Power LED  comes on.

   If the LED doesn’t come on, refer to Chapter 5-4.

4)If you attached a storage SCSI device to the FR1SX and its icon mounted on

   the desktop, you have successfully installed the FR1SX.

   If the driver/application of your SCSI device has only SCSI API and you

   want to use them on Mac OS 9.x, you need to install B’sCrew SIM driver.

   In order to install the B’sCrew SIM driver, proceed to Chapter 2-4.

FireWire port

  FireWire cable

Fig. 5
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If you have the following devices/software((1)-(4)) and intend to use them with

the FR1SX on MacOS 9.x, you must install B’sCrew SIM driver. After

installing it, you can use them on MacOS 9.x. But please note this B’sCrew

SIM driver doesn’t work on MacOS X. This driver runs on MacOS 9.x only.

(1)SCSI Film Scanners/Flat Bed Scanners. The scanner TWAIN driver has

     only SCSI API.

(2)SCSI Removable Storage Devices such as ORB. The Disk Utility software

    has only SCSI API.

(3)SCSI CD-RW devices. The writing software doesn’t support FireWire.

    (NOTE)If you have the writing software Toast, you can download

                 Toast FireWire Support and use it. You don’t need to install

                  this B’sCrew SIM driver.

(4)SCSI devices of which the specified driver/application has only SCSI API.

2-4.B’sCrew SIM driver

B’sCrew SIM driver works as shown above.
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This B’sCrew SIM driver has the following restrictions:

(1)The SIM Driver mode on FR1SX firmware operating mode must be set

     enable(Default setting is enable).  You can set or reset this mode with the

     SCSI Configuration utility. Refer to section B in the Chapter 4-2-1.

(2)The SIM driver doesn’t support FireWire Plug and Play, Hot Swapping

     because the original SCSI API doesn’t include these features.

(3)As the SIM driver hooks the standard SCSI APIs for Add-on SCSI ports

     and substitute for FireWire API, some SCSI applications or drivers which

     dedicates for the embedded SCSI port or doesn’t call standard SCSI API

     will not work properly.

(4)The B’sCrew SIM driver has some compatibility issues with SCSI devices.

     Please refer to our compatibility list on our web site before using it.

(5)The SIM driver doesn’t support system boot from a SCSI device connected

     to the FR1SX.

Follow the steps through to install this B’sCrew SIM driver.

(1)Insert the bundled CD-ROM and start [B’sCrew SIM Driver Installer] in

     the [B’sCrew SIM Driver] folder.

(2)Note and tips will appear. Click [Continue].

(3)Make sure the install location on the screen. Click [Install].

(4)Message screen will appear. Click [Conitnue].

(5)Message screen saying install was successful will appear. Click [Restart].
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(6)B’sCrew SIM FireREX1 file is copied in the [Extensions] folder.

     This B’sCrew SIM FireREX1 is enabled.

Only when you want to use the devices/software((1)-(4)) described in Page 12,

you must set the B’sCrew SIM FireREX1 enabled(The B’sCrew SIM

FireREX1 is set enable when this driver has been installed). If you don’t use

the devices/software((1)-(4)), set the B’sCrew SIM FireREX1 disabled with

the [Extensions Manager]. If you set B’sCrew SIM FireREX1 disabled,

you can use the FR1SX to recognize a SCSI device as a FireWire device.

Here is the explanations of how to use B’sCrew SIM driver:

(1)Example 1

      If you want to use a SCSI Scanner with the FR1SX and will not use any

      other devices, FireWire Hot Swapping, Plug and Play, please refer to the

      following steps.

     A.The SIM Driver mode on FR1SX firmware operating mode must be set

         enable(Default setting is enable).

     B.The B’sCrew SIM driver must be set enable.

     C.Turn off your Mac and hook up the FR1SX/Scanner to a FireWire port.

     D.Turn on the Scanner. Please make sure the green LED of the FR1SX

         comes on. If not, please check the Term-Power at the scanner SCSI

         connector. Refer to Chapter 5-4 for more information.

     E.Turn on your Mac.
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     F.With the Devices and Volumes menu in the Apple system profiler,

          you can check to see if the scanner is recognized as a SCSI device.

(2)Example 2

      If you want to share one FR1SX with two different SCSI devices such as a

      Scanner and HDD and use FireWire HDD driver which supports Hot

      Swapping and Plug and Play, please refer to the following steps.

     A.If you use a SCSI scanner, use it as described in Example 1.

     B.If you want to change from the scanner to the HDD, set the B’sCrew

         SIM FireREX1 disabled with the [Extensions Manager] before

         shutting down the Mac.

     C.Turn off the Mac and remove the FR1SX and the scanner.

     D.Turn on the Mac and start MacOS.
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  E.After the MacOS starting up, hook up the FR1SX/HDD to a FireWire port.

  F.The icon of the SCSI HDD will be mounted on the desktop.

  G.If you want to use the scanner again, unmount the HDD, remove it and

      set the B’sCrew SIM FireREX1 enabled again with the [Extesions

      Manager]. And then, follow Example 1-B to E.

(3)Example 3

      If you have two FR1SX and hook up them to a scanner and HDD each

      in daisy-chain, please refer to the following steps.

     A.The SIM Driver mode on the FR1SX attached to the scanner must be set

         enable(Default setting is enable). The SIM Driver mode on the FR1SX

         attached to the HDD must be set enable(Default setting is enable).

         You can set or reset this mode with the SCSI Configuration utility. Refer

         to section B in the Chapter 4-2-1.

     B.The B’sCrew SIM driver must be set enable.

     C.Turn off your Mac and hook up the “SIM enabled” FR1SX and scanner

         to a FireWire port.

     D.Turn on the scanner. Please make sure the green LED of the FR1SX

         comes on. If not, please check the Term-Power at the scanner SCSI

         connector. Refer to Chapter 5-4 for more information.

    E.Turn on your Mac and start MacOS.



    M
acintosh

17

    F.With the Devices and Volumes menu in the Apple system profiler, check

        to see if the scanner is recognized as a SCSI device.

    G.Hook up “SIM Disabled” FR1SX and the HDD to the FR1SX/scanner

       in daisy-chain. The HDD will be mounted automatically. The SIM driver

       detects the FR1SX operating mode and switch itself.

FR1SX

SCANNER HDD
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3.Repeater

The FR1SX works as a FireWire repeater as Fig.6 shows. It extends the

distance between one FireWire device and another FireWire device up to 9m

(30 feet). In this case, an OPTIONAL AC adapter(sold separately) is required

to provide the power. To purchase an AC adapter, refer to Chapter 7.

OPTIONAL AC adapter
AC adapter Jack

Fig. 6
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4.Installing Utility
You can do the followings with the bundled utility:

-You can configure settings for the SCSI device.

-You can update the firmware on the FR1SX.

-You can format a HDD, MO, Zip, Jaz, etc.

Follow the steps to install it:

If you use Windows, proceed to Chapter 4-1.

If you use Mac, proceed to Chapter 4-2.

4-1.Installing on Windows
1)Click the hardware removable icon on the TaskBar. Select the pop-up menu

    saying [Stop xxx-Disk(X:)]. “You can safely remove the device” message

    will appear. Click [OK]. Then, remove the 1394 cable from the FR1SX.

2)Insert the bundled CD-ROM.

3)Start the [Setup.exe] file at the CD-ROM and follow the instructions.

4)After the installation, you can find [FR Format utility] and

    [FR Configuration] in the [RATOC FireWire Utility] in the [Programs]

    on the [Start] menu. Refer to Chapter 4-1-1 for the FR Format utility

    information and Chapter 4-1-2 for the FR Configuration information.
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A.How to use FRFMTW9X on Windows Me/98SE

Follow the steps through to format your SCSI drive:

1)Make sure the SCSI device is connected and powered on.

2)If the device is a removable disk and its media is not inserted, insert a media.

3)From the [Start] menu, select [Programs], then [RATOC FireWire

   Utility], and then [FR Format utility].

You can format a HDD, Jaz, MO, Zip drive, etc.,with this utility.

(Caution)

You can not format a CD-R, CD-RW or DVD-RAM.

If you use Windows 98 SE or Windows Me, proceed to section A.

If you use Windows 2000, proceed to section B.

4-1-1.FR Disk Formatting and Partitioning Utility



21

    W
indow

s

7)The Initialize/Format screen will appear. Select format type. If you want to

   do Low Level Format simultaneously, check [Low Level Format]. Then,

   click [OK].

(Caution)

All the devices, connected to USB, SCSI

port on the PC besides 1394, will be shown.

Be sure to select the drive connected to the

FR1SX.

5)The following window will appear and select the drive you want to format.

   And click the [Select] button.

6)The following window will appear. Select [Initialize/Format media] from

    the [Edit] menu.
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8)If you selected IBM-PC/AT FDISK format at step 7), the message box

   saying [You should create partition next] will appear. Then, click [OK].

   You will see the screen shown at the step 6) and select [Create Partition]

   from the [Edit] menu. And then, you will see the screen below. Select [File

   System] from the list box and set Partition size, using the slider bar. Then,

   click [OK] to create partition. If you selected Super FD format at step 7),

   you will see a screen similar to the following. Select [File System] from the

   list box.

9)You must restart your computer for your information to take effect.

    If you are using a removable media, the media will be ejected to take effect.

    So, you don’t need to restart your computer.

Slider Bar
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B.How to use FRFMTW2K on Windows XP/2000
If you format a HDD, removable disk on Windows XP/2000, you usually

use Disk Management in the Computer Management in Windows XP/

2000. But, when you failed to format the HDD or a new drive letter will not

be assigned after you have done Disk Management, you should do Low

Level Format, using this format utility FRFMTW2K.EXE.

Follow the steps through to do Low Level Format.

1)Make sure the SCSI device is connected and powered on.

2)If the device is a removable disk and its media is not inserted, insert a media.

3)From the [Start] menu, select [Programs], then [RATOC FireWire

   Utility], and then [FR Format utility].

4)The message box appears. Click [OK].

5)The following window will appear. Select the drive and click [Start].

6)After finishing, you have to write signature

   on the disk and format the disk, using Disk

    Management in Windows XP/2000.

    For more information, refer to a Windows

    XP/2000 help file.
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4-1-2.FR  Configuration Utility

With this FR Configuration utility, you can configure settings for the SCSI

device or update the old firmware data.

(NOTE)

Don’t connect any1394 devices/repeaters to a PC/the FR1SX directly or

in between.

1)From the [Start] menu, select [Programs], then [RATOC FireWire

   Utility], and then [FR Configuration].

2)The message box saying “reconnect the 1394 cable” will appear. Follow the

    message instruction.

3)When you start the FR Configuration on Windows 2000 for the first time,

    hardware wizard will appear. Just continue by clicking [Next] and click

    [Finish] at the last window. Then, restart your PC. After your PC

   restarting, start the FR Configuration again.

4)Make sure the [Setting was successful] message appears as shown in the

     next page.
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You can finish this FR configuration by clicking [EXIT].

Refer to section A for the [Firmware update Utility] information.

Refer to section B for the [Config Utility] information.
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A.How to update the FR1SX Firmware

With this firmware update utility, you can update the old firmware to the

latest one available through our web site.

To update the old firmware, follow the steps:

1)Select the [Firmware update Utility] button shown in the previous page.

   The following screen will appear. The highest row indicates the firmware

    data you are about to write. The lowest row indicates the firmware version

    the FR1SX has now.

2)If you want to write another firmware, click [Browse] and select it.

3)After selecting the firmware, click [Write].

4)When the update is successful, the message box will appears. Click [OK].

5)If your PC is running Windows 2000, restart your PC.

    If your PC is running Windows Me/98SE/XP, you don’t need to restart it.
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B.How to configure the SCSI parameters
Follow the steps through to use the SCSI configuration utility.

[FireREX1/FR1SX SCSI ID] FR1SX SCSI ID is No. 7.

[Transfer Mode] Default value is 20MB/s.You can set Max transfer rate

from 20,10,5MB/s, Async.

[Advanced] When you click this button, the window shown in the next page

will appear.

[Default] When you click this button, the default settings will be loaded.

[Write]When you click this button, the settings will be loaded. Then, click

[Back] to go back to the main menu and click [EXIT] to finish the utility.

If you use Windows 2000, you have to restart your computer for your

changes to take effect. If you don’t use it, you don’t need to restart.

[Back] When you click this button, you go back to the main menu.

1)Start [FR Configuration]. Refer to Chapter

   4-1-2 for how to start the FR Configuration.

2)Select the [Config Utility] button on the main

   menu.

3)The following window will appear.

    The setting items are as follows:
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Advanced setting items as shown above are as follows.

[Delay time between power on and SCSI bus reset]
Default value is 0. You can set delay time for some SCSI devices which hang
up if SCSI bus reset is issued right after the FR1SX gets powered. Set this
value to 2 for Castle Wood ORB drive, Canon FB620S or Sharp JX-370.

[Delay time between SCSI bus reset and SCSI command]
Default value is 1. You can set delay time for some SCSI devices which hang

up if SCSI command is issued right after SCSI bus resets.
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[Delay time until 1394 transaction start]
Default value is 4.You can set delay time for some SCSI devices which will
not receive any command if a next command is issued right after Start/Stop
Unit command is issued.

[Enable SCSI bus reset]
Default value is enabled.You can set whether the FR1SX issues SCSI bus
reset to a SCSI device or not.

[Enable START UNIT command]
Default value is disabled. You have to enable START UNIT command for
some SCSI devices which will not work if they does not receive this START
UNIT command.

[Enable parity check]
Default value is enabled. You can set parity check enable or disable.

[Target SCSI ID.]
Default value is AUTO. You can set target SCSI ID No.

[Max Payload Size]
Default value is 1024. You can set Max byte size in
transferring IEEE1394 Read/Write DataBlock. Max size is 2048 Bytes. But,
if a data error happens during data transfer, you should set this value to 1024
Bytes to avoid the error.
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4-2.Installing on Macintosh

As described below, duplicate Mac OS Base with the [Extensions

Manager] before installing/using the utility. Then, change the duplicated set

to the previous set after finishing the utility. If you use Mac OS X, refer to

Chapter 4-2-2.

1)Open [Extensions Manager].

2)Change selected set from your settings to [Mac OS Base] and click

   [Duplicate Set...].

3)The following window will appear. Type in a name such as [FIREREX

    CONFIGURATION] and click [OK]. Then, disable the following

    function:

    •Authoring Support

    •FireWire Authoring Support

    •Disc Burner Extention

4)Insert the bundled CD-ROM.

4-2-1.Installing on Mac OS 9.1.x/9.2.x
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6)Start FR1 Installer-E at the [FRUTY] folder at the [FR1SX for OS 9] in

    the CD-ROM. License agreement will appear. Click [Accept].

7)The following window will appear. Make sure the install location and click

   [Install].

8)The message saying “Installation was successful...” will appear. Click

   [Quit].

9)[FRUTY] folder is created in the location you have confirmed at Step 7).

   Open the folder and start [FR1 Utility].The following window will appear.

   Click [OK].

10)You can start the following utility from the [File] menu.  You can

      configure settings for the SCSI device or update the old firmware data.

      - Proceed to section A for Firmware update Utility.

      - Proceed to section B for SCSI Configuration Utility. .
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A.How to update the FR1SX Firmware

With this firmware update utility, you can update the old firmware to the

latest one available through our web site.

1)Before starting this utility, make sure the following 4 points:

a.Open [Extensions Manager] and make sure selected set is [FIREREX1

    CONFIGURATION] as described in Chapter 4-2-1.

b.Make sure the following two driver is enabled with [Extensions Manager].

    -FireREX1APIDriver / FireREXLoaderDriver

c.Make sure the following two driver is disabled with [Extensions Manager].

    -Authoring Support / FireWire Authoring Support/Disc Burner Extention

d.Don’t connect any1394 devices/repeaters to a PC/the FR1SX directly or

   in between.

2)Open the [FRUTY] folder and start

   [FR1 Utility].The following window

   will appear. Click [OK].

3)Select [Firmware update Utility]

   from the [File] menu. The following

   window will appear. Firmware Rev

   indicates the current firmware

  revision the FR1SX has now.
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4)When you click [Select New Firmware Data File], the following

   window will appear. Select new firmware data file and click [Open].

5)The window shown at the step 3) will appear again. Click [Write].

   When the message says “Updating was successful”, click [OK].

   Click [Quit] from the [File] menu.

6)Change selected set from  [FIREREX CONFIGURATION ] to the

   previous settings you used before with the [Extensions Manager]. Then,

    restart your Mac for your chages to take effect.
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3)Select [Config Utility] from the [File] menu. The window shown in the

   next page will appear. For setting information, refer to the next page.

4)After configuring the SCSI parameter, change selected set from  [FIREREX

   CONFIGURATION ] to the previous settings you used before with the

   [Extensions Manager]. Then, restart your Mac.

1)Before starting this utility, make sure the following points:

a.Open [Extensions Manager] and make sure selected set is [FIREREX1

    CONFIGURATION] as described in Chapter 4-2-1.

b.Make sure the following two driver is enabled with [Extensions Manager].

    -FireREX1APIDriver / FireREXLoaderDriver

c.Make sure the following two driver is disabled with [Extensions Manager].

    -Authoring Support / FireWire Authoring Support/Disc Burner Extention

d.Don’t connect any1394 devices/repeaters to a PC/the FR1SX directly or

   in between.

2)Open the [FRUTY] folder and start [FR1 Utility].The following window

   will appear. Click [OK].

B.How to configure the SCSI parameters
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[FireREX1/FR1SX SCSI ID] FR1SX SCSI ID is No. 7.

[Transfer] Default value is 20MB/s.You can set Max transfer rate from

20,10,5MB/s, Async.

[SIM Driver mode] This setting is usually checked(Enalbed). This item is

used with B’sCrew SIM driver. Refer to Chapter 2-4.

[Advanced] When you click this button, the window shown in the next page

will appear.

[Default] When you click this button, the default settings will be loaded.

[Exit] Click this button to end this utility. Then, select [Quit] from the [File]

menu to finish it.

[Write]When you click this button, the settings will be loaded. Then, click

[Exit]. The message saying the updating is successful will appear. Click [OK].

After that, select [Quit] from the [File] menu to finish this utility.
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Advanced setting items as shown above are as follows.

[Target SCSI ID.]
Default value is AUTO. You can set target SCSI ID No.

[Enable parity check]
Default value is enabled. You can set parity check enable or disable.

[Delay time between power on and SCSI bus reset]
Default value is 0. You can set delay time for some SCSI devices which hang
up if SCSI bus reset is issued right after the FR1SX gets powered. Set this
value to 2 for Castle Wood ORB drive, Canon FB620S or Sharp JX-370.

[Delay time between SCSI bus reset and SCSI command]
Default value is 1. You can set delay time for some SCSI devices which hang
up if SCSI command is issued right after SCSI bus resets.
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[Delay time until 1394 transaction start]
Default value is 4.You can set delay time for some SCSI devices which will
not receive any command if a next command is issued right after Start/Stop
Unit command is issued.

[Enable SCSI bus reset]
Default value is enabled.You can set whether the FR1SX issues SCSI bus
reset to a SCSI device or not.

[Enable START UNIT command]
Default value is disabled. You have to enable START UNIT command for
some SCSI devices which will not work if they does not receive this START
UNIT command.

[Max Payload Size]
Default value is 1024. You can set Max byte size in transferring IEEE1394
Read/Write DataBlock. Max size is 2048 Bytes. But, if a data error happens
during data transfer, you should set this value to 1024 Bytes to avoid the
error.

[Cancel]
If you click this button, you go back to the main menu without saving.

[Back]
If you click this button, you go back to the main menu after saving.
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4-2-2.Starting on Mac OS X

1)Connect the FR1SX to the FireWire port and turn on the SCSI device.

2)Insert the bundled CD-ROM.

3)Open the [FR1SX for OS X] folder and then, open the [FRUTY_OS_X].

4)Start [FR1Utility]. The following window will appear. Clcik [Enable FR1

   Utility].

With this firmware update utility, you can configure settings for the SCSI

device or update the old firmware data.
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5)You will be requested to type in an administration password.

    Type in an administration password and click [OK].

6)You will be requested to restart your system.

    Click [OK] to restart your system.

7)Start the [FR1Utility] again.

    The following window will appear.

      - Proceed to section A for

       Firmware update Utility.

      - Proceed to section B for

       SCSI Configuration Utility.
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A.How to update the FR1SX Firmware

With this firmware update utility, you can update the old firmware to the

latest one available through our web site.

1)Start the FR1 utility as described at step 1-7 in chapter 4-2-2.

2)The main window will appear. Click [Select firmware data].

    Select new firmware data on the next window and click [Open].

3)Click [Start Firmware update] on the main window.

4)After updating the firmware data, the following window will appear.

   Click [OK].

5)Click [Disable FR1 Utility] on the main window.

6)The following window will appear. Type in an administration password.

    Then, click [OK].

7)You will be prompted to restart your system.Click [OK].
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B.How to configure the SCSI parameters

1)Start the FR1 utility as described at step 1-7 in chapter 4-2-2.

2)The main window shown in the next page will appear.

    Refer to the next page for setting items information.

3)After changing your settings, click [Start Configuration setting].

4)After finishing the configuration settings, the following window will appear.

    Click [OK].

 With this firmware update utility, you can configure settings for the SCSI

device

5)Click [Disable FR1 Utility] on the main window.

6)The following window will appear. Type in an administration password.

    Then, click [OK].

7)You will be prompted to restart your system.Click [OK].
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[SIM Driver mode] This setting is usually checked(Enalbed). This item is

only for MacOS 9.x.

[Speed] Default value is 20MB/s.You can set Max transfer rate from 20, 10

,5MB/s, Async.
[Parity check]
Default value is enabled. You can set parity check enable or disable.

[FireREX1/FR1SX SCSI ID] FR1SX SCSI ID is No. 7.
[SCSI bus reset]
Default value is enabled.You can set whether the FR1SX issues SCSI bus
reset to a SCSI device or not.
[Target SCSI ID.]
Default value is AUTO. You can set target SCSI ID No.
[Enable START/STOP UNIT command]
Default value is disabled. You have to enable START UNIT command for
some SCSI devices which will not work if they does not receive this START
UNIT command.
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[Delay time between power on and SCSI bus reset]
Default value is 0. You can set delay time for some SCSI devices which hang
up if SCSI bus reset is issued right after the FR1SX gets powered. Set this
value to 2 for Castle Wood ORB drive, Canon FB620S or Sharp JX-370.

[Delay time between SCSI bus reset and SCSI command]
Default value is 1. You can set delay time for some SCSI devices which hang
up if SCSI command is issued right after SCSI bus resets.

[Delay time until 1394 transaction start]
Default value is 4.You can set delay time for some SCSI devices which will
not receive any command if a next command is issued right after Start/Stop
Unit command is issued.

[Max Payload Size]
Default value is 1024. You can set Max byte size in transferring IEEE1394
Read/Write DataBlock. Max size is 2048 Bytes. But, if a data error happens
during data transfer, you should set this value to 1024 Bytes to avoid the
error.

[Default]
When you click this button, the default settings will be loaded.

[Start Configuration setting]
If you click this button, the settings will be loaded. Then,
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5.Troubleshooting
5-1.General Hardware Troubleshooting

� Make sure the FR1SX’s power LED comes on. If the LED does not come on,

    your SCSI device may not provide SCSI bus termination power. If the

    SCSI device can not provide it, an OPTIONAL AC adapter is required.

    For purchasing information, refer to Chapter 7.

� Make sure the FR1SX is firmly connected to your SCSI device.

� Make sure the 1394 cable is firmly connected to the FR1SX and a 1394 port

    on your PC or Mac.

� Make sure you are using the 1394 cable bundled in this package.

� Make sure the SCSI device has a SCSI ID except 7.

� Make sure the SCSI power cable is properly connected and the SCSI device

    is powered.

� If the SCSI device is powered from an AC adapter, the SCSI device may

     not have the capability of providing enough termination power to the FR1SX.

    We recommend you use an OPTIONAL AC adapter to avoid it.

    For purchasing information, refer to Chapter 7.

� Make sure a terminator is attached to the SCSI device or the terminator

    switch on the SCSI device is in Power-Off state.
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5-2.When you fail to copy files

When you come across an error message during copying files or the system

locks up, you should phase down transfer rate with the SCSI configuration

utility. If you use the older MO models made by FUJITSU such as M2512A,

M2513A, the system sometimes locks up.

If you use the older FUJITSU MO(M2512A, M2513A), remove the FR1SX

from the SCSI device and attach the FR1SX to another SCSI device to set

transfer rate to 10MB/sec with the SCSI configuration utility. Please note you

can not execute the SCSI configuration utility with the older FUJITSU MO

models attaced to the FR1SX. You have to attach the FR1SX to another SCSI

device.

If you use Windows, proceed to section B in Chapter 4-1-2. With the SCSI

configuration utility, phase down the transfer rate to see if it is successful.

If you use Mac OS 9.x, proceed to section B in Chapter 4-2-1. With the

SCSI configuration utility, phase down the transfer rate to see if it is successful.

If you use Mac OS X, proceed to section B in Chapter 4-2-2. With the SCSI

configuration utility, phase down the transfer rate to see if it is successful.
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5-3.When a new drive letter is not assigned(Windows)

When you connect a HDD which is not formatted or does not have partition, a

new drive letter will not be assigned in [My Computer]. You need to format or

create partition on the HDD.

1.When you use Windows Me/98SE, you can format your HDD and create

   partition, using “FRFMTW9X.EXE”.

   For more information, refer to section A in Chapter 4-1-1.

2.When you use Windows XP/2000, you can format your HDD and create

   partition, using Disk Management in Windows XP/2000. For more

   information, refer to a Windows XP/2000 help file. If a new drive letter

   will not be assigned yet or you fail to format the HDD after you have done

   Disk Management, you should do Low Level Format, using

   “FRFMTW2K.EXE”. For more information, refer to section B in

   Chapter 4-1-1.
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5-4.When the green power LED does not come on

       (Win/Mac)

Check the following points:

1)Make sure the SCSI device is powered on properly.

2)Turn off the SCSI device and check the FR1SX is attached firmly.

   And turn on the device again.

   If the LED does not come on even if above checking was made, refer to the

   user’s document of the SCSI device. SCSI specifications require Term-Power

   output capability as an optional, but some SCSI devices such as

   iomega Zip drive may not be implemented this capability. If your SCSI

   device does not have this Term-Power output capability, you have to connect

   an OPTIONAL AC adapter(sold separately) as Fig.7 shows. For purchasing

   information, refer to Chapter 7.

Optional AC adapter
AC adapter jack

Fig. 7
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5-5.When you connect two or more FR1SX  in daisy-chain,

       your system can not recognize them (Win/Mac)

Follow the steps to connect two or more FR1SX in daisy-chain.

1)Make sure all SCSI devices are powered off and then connect FR1SX to each

    SCSI device.

2)Connect the FR1SX in daisy-chain via 1394 cables.

3)Power up all the SCSI devices.

4)Connect a FR1SX to a 1394(FireWire) port on the PC/Mac via a 1394 cable.
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5-6.How to attach to the SCSI-1(Centronics50P, DB25)

       device(Win/Mac)
1)If you have a SCSI device with a Low-Density Centronics 50 pin

   connector, a High-Density 50 pin(Female) to Low-Density Centronics 50

   pin(Male) adapter(RCL-3005) is available from us. You can connect

   your SCSI device, using this adapter.For purchasing information, refer to

   Chapter 7.

2)If you have a SCSI device with a DB25 pin connector, a High-Density 50

   pin(Female) to DB25 pin(Male) adapter(RCL-3025) is available from

   us. You can connect your SCSI device, using this adapter. For purchasing

   information, refer to Chapter 7.
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5-7.Wrong drive name appears on the removable icon

       (Win98SE/Win Me)
When you click the hardware removable icon on the TaskBar, you may see a

wrong drive name. This happens on Windows 98 SE or Me.(The following

screen shows a example when you connect a CD-R drive. It shows IEEE 1394

Disk, instead of CD-ROM.)

Follow these steps through to show the right drive name.

1)Open [Device Manager].

2)When you use Windows 98 SE, you can find a string named [IEEE1394

   CD-ROM], [IEEE1394 Disk], or [IEEE1394 Optical Disk] under the

   [Storage device]. When you use Windows Me, you can find a string named

   [IEEE1394 CD-ROM],[IEEE1394 Disk],[IEEE1394 Floppy],[IEEE1394

   Optical Disk] or [IEEE1394 Tape] under the [Storage device].

   Double click the wrong drive name string.

3)You will see the properties window. Click the [Driver] tab and click

    [Update Driver].

4)[Update Device Driver Wizard] will start up. When you use Windows Me,

   check [Specify the location of the driver(Advanced) ] and click [Next].

    When you use Windows 98 SE, just click [Next].
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5)You will see the next screen.Check [Display a list of all the drivers in a

    specific location, so you can select the driver you want] and click [Next].

6)You will see the next screen saying “select the manufacturer and model of

    your hardware device”. Check [Show all hardware] and select the right

    drive name from the list. Click [Next]. Update Driver Warning message

    may appear. In such a case, just click [Yes].

7)You will see the next screen saying “Windows driver file search for the

    device”. Click [Next].

8)You will see the next screen saying “Windows has finished installing

    the driver you selected for your hardware device.” Click [Finish].
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5-8.Wrong device icon appears in [My Computer]

       (Win2000/XP)

If you exchange SCSI devices on Windows2000/XP, as shown below, the de-

vice icon in [My Computer] will not change. You can still find the previous

drive icon in [My Computer].

  Change a device from                   To                      Icon in [My Computer]

  CD-ROM,CD-R/RW        HDD/Jaz/Zip drive             CD-ROM

  HDD/Jaz/Zip drive           CD-ROM,CD-R/RW            Removable

Follow these steps through to update driver so that you can resolve this issue.

1)Right-click on [My Computer] and select [Properties].

2)You will see [System Properties] windows. Click the [Hardware] tab.

3)Click the [Device Manager] button. You will see the screen in the shown

    in the next page.



53

4)If you have changed from a CD-ROM or CD-R/RW to a Removable disk or

   HDD, you can find a [RATOC Systems_Inc. IEEE1394-SCSI-3

   IEEE1394 SBP2 Device] string under the [DVD/CD-ROM drives].

   If you have changed from a Removable disk or HDD to a CD-ROM or CD-

   R/RW, you can find a [RATOC Systems_Inc. IEEE1394-SCSI-3

   IEEE1394 SBP2 Device] string under the [Disk drives].

   Double click on the [RATOC Systems_Inc. IEEE1394-SCSI-3

   IEEE1394 SBP2 Device] string to show its property.
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5)Select [Driver] tab on the screen and click the [Update Driver] button.

6)[Update Device Driver Wizard] will start up. Click [Next].

7)[Install Hardware Device Drivers] window will appear. Check [Search

   for a suitable driver for my device(recommended)] and click [Next].

8)[Locate Driver Files] window will appear. Unchech all the options at

    Optional Search locations:. Click [Next].

9) [Driver Files Search Results] window will appear. Click [Next].

10)[Completing the Upgrade Device Driver Wizard] window will appear.

     Click [Finish].

    Open [My Computer] to see if the right icon appears in [My Computer].

5-9.When Version Conflict message appears(Win98SE)

When you use Windows 98 SE, you may see a screen similiar to the following.

Click [Yes] all the time for the question “Do you want to keep this file?”
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5-10.Write error happens to Castlewood ORB(Win/Mac)

The AC adapter the Castlewood ORB uses may not be able to provide enough

termination power for the FR1SX to work. You should purchase an OPTINAL

AC adapter. Refer to Chapter 7.

5-12.CD-R/RW writing software can not recognize the

         CD-R/RW drive connected to the FR1SX. But,the

         MacOS recognizes the CD-R/RW (Mac)

The writing software you are using may not be able to treat FireWire interface.

You have to use the writing software which can treat FireWire or install B’s

Crew SIM driver. Refer to Chapter 2-4 for the driver information.

5-11.Castlewood ORB can not be recognized when you

          start your computer with ORB connected(Win/Mac)

Set 2 seconds at [Delay time between power on and SCSI bus reset] with

the SCSI configuration utility. For more information, refer to section B in

Chapter 4-1-2(Windows users), section B in Chapter 4-2-1(MacOS9.x users),

or section B in Chapter 4-2-2(MacOS X users).
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6.Registration and Tech-Support
6-1. How to Register

We highly recommend to register yourself as our customer through our

on-line registration. (http://www.ratocsystems.com/english/)

6-2. Software Update and Support

-Utility Update-

The latest utility is subject to change for improvement or bug fix.You can

download the latest version from our web site.

-Technical Support-

You can get a Tech support from RATOC at the following:

(Open Monday - Friday,9:30A.M. to 5:00P.M.(PST))

RATOC Systems International,Inc. Tech support

Address: 1933 O’Toole Avenue Suite A109

SanJose, CA 95131, U.S.A.

Phone : (408)955-9400  Fax : (408)955-9402

E-mail : int-support@rexpccard.co.jp

Web : http://www.ratocsystems.com/english/

Please include the following information:

•Our product name, serial number, and product description

•Host Computer Name, OS version,CD-ROM version
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7.Options

Optional AC adapters, FireWire(IEEE1394) cables, etc. are available

 (sold separately) at the web site:

   1.http://www.ratocsytems.com/english/

   2.http://www.firewireshop.com

    -AC05            (AC Adapter, Input AC100-240V, Output DC 5V, 2A)

    -RCL-3005    (HD50F to C50P adapter)

    -RCL-3025    (HD50F to DB25P adapter)

    -CBFW-466   (4P-6P FireWire(IEEE1394) cable (6 feet))

    -CBFW-666   (6P-6P FireWire(IEEE1394) cable (6 feet))

    -CBFW-463   (4P-6P FireWire(IEEE1394) cable (3 feet))

    -CBFW-663   (6P-6P FireWire(IEEE1394) cable (3 feet))

If you have any questions about these options, contact to:

RATOC Systems International, Inc. Tech support:

   Tel      : (408)955-9400

   Fax     : (408)955-9402

   E-mail: int-sales@rexpccard.co.jp
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8.Specifications
Product Name :FR1SX

Transfer          :SCSI

  •Max synchronous transfer 20MBytes/sec

    (When you connect an Ultra SCSI device)

  •Max synchronous transfer 10MBytes/sec

    (When you connect a SCSI-2 device)

  •Max asynchronous transfer 6MBytes/sec

                        FireWire

              •100/200/400Mbps

SCSI connector:High-Density 50 pin male SCSI-2 connector x 1

1394(FireWire) connector: 6pin x 2

Size:2.17 in (55 mm) (W) x 2.56 in (65 mm) (D) x 0.59 in (15 mm) (H)

Weight:1.69 oz (48 g)

Power Requirements :DC +4.25V to 5.25V

                         (SCSI Termination Power is  required)

             300 mA typical

Optinal AC Adapter :Input AC100-240V, Output DC 5V, 2A

(Model Name:AC05)

Polarity
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Appendix
Trademarks

-Windows is a registered trademark of Microsoft Corporation.

-MacOS, PowerMacintosh, PowerBook and Mac logo are registered trademarks

 of Apple Computer,Inc.

-Other brand and product names may be registered trademarks or trademarks of

 their respective holders.

Regulatory Agency Notice
FCC Compliance Statement

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part

15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in

a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not

installed and used in accordance with the instructions, may cause harmful interference to radio communica-

tions. However, there is no guarantee that interference will not occur in a particular installation. If this

equipment does cause harmful interference to radio or television reception, which can be determined by

turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the

following measures:

(1) Reorient or relocate the receiving antenna.

(2) Increase the separation between the equipment and receiver.

(3) Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

(4) Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications not expressly approved by the party responsible for compliance may result in this

unit not complying with FCC Rules Part 15.

To meet EN55022(Class B) and EN55024 requirements, you have to use a IEEE1394(FireWire) cable less than

3 m.
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